<table>
<thead>
<tr>
<th>Document Number:</th>
<th>0372030A / FLN-29008-PG</th>
</tr>
</thead>
<tbody>
<tr>
<td>Revision:</td>
<td>0 - draft</td>
</tr>
<tr>
<td>File:</td>
<td>~/Programmer guide.doc</td>
</tr>
<tr>
<td>Subject:</td>
<td>Programmer Guide</td>
</tr>
<tr>
<td>Part of:</td>
<td>Documentation</td>
</tr>
<tr>
<td>System:</td>
<td>Symbion S3X</td>
</tr>
<tr>
<td>Author:</td>
<td>Adam Shaw (<a href="mailto:ads@orbotech.com">ads@orbotech.com</a>)</td>
</tr>
<tr>
<td>Date:</td>
<td>05/07/2004</td>
</tr>
<tr>
<td>Status:</td>
<td>Draft</td>
</tr>
<tr>
<td>Notes:</td>
<td></td>
</tr>
<tr>
<td>Revisions:</td>
<td></td>
</tr>
<tr>
<td>05/07/2004</td>
<td>First draft begun</td>
</tr>
<tr>
<td>19/04/2005</td>
<td>First Draft – Version 1</td>
</tr>
<tr>
<td>26/04/2005</td>
<td>First Draft – Version 2</td>
</tr>
<tr>
<td>08/06/2005</td>
<td>First Draft – Version 3</td>
</tr>
<tr>
<td>15/06/2005</td>
<td>First Draft – Version 4</td>
</tr>
<tr>
<td>27/06/2005</td>
<td>First Draft – Version 5</td>
</tr>
<tr>
<td>30/06/2005</td>
<td>First Draft – Version 6</td>
</tr>
<tr>
<td>Author Approval:</td>
<td></td>
</tr>
<tr>
<td>R&amp;D Approval:</td>
<td></td>
</tr>
<tr>
<td>QA Approval:</td>
<td></td>
</tr>
<tr>
<td>Document Approved:</td>
<td></td>
</tr>
<tr>
<td>Revisions:</td>
<td>05/07/2004</td>
</tr>
<tr>
<td>------------</td>
<td>------------</td>
</tr>
<tr>
<td>19/04/2005</td>
<td>First Draft, Ver. 1 Released</td>
</tr>
<tr>
<td>26/04/2005</td>
<td>First Draft, Ver. 2 Improved Multiboard Description</td>
</tr>
<tr>
<td>08/06/2005</td>
<td>First Draft, Ver 3. Changes to chapter order, addition of macro, block skip information.</td>
</tr>
<tr>
<td>15/06/2005</td>
<td>First Draft, Ver 4. Basic operation section reduced in favor of Operator Guide</td>
</tr>
<tr>
<td>27/06/2005</td>
<td>First Draft, Ver 5. Section added on OCR, Macro Updated,</td>
</tr>
<tr>
<td>30/06/2005</td>
<td>First Draft Ver 6. Sections updated on saving recipes, maintenance, solder inspection setup</td>
</tr>
</tbody>
</table>
## Contents

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Contents</strong></td>
<td>i</td>
</tr>
<tr>
<td><strong>Preface</strong></td>
<td>1</td>
</tr>
<tr>
<td>About This Document</td>
<td>1</td>
</tr>
<tr>
<td>Typography</td>
<td>1</td>
</tr>
<tr>
<td>Prerequisites</td>
<td>2</td>
</tr>
<tr>
<td><strong>System Overview</strong></td>
<td>3</td>
</tr>
<tr>
<td>Symbion Concept</td>
<td>3</td>
</tr>
<tr>
<td><strong>Basic Operation</strong></td>
<td>5</td>
</tr>
<tr>
<td>Starting the System</td>
<td>5</td>
</tr>
<tr>
<td>The Welcome Screen</td>
<td>6</td>
</tr>
<tr>
<td>Inspecting Production</td>
<td>7</td>
</tr>
<tr>
<td>Shutting Down the System</td>
<td>8</td>
</tr>
<tr>
<td><strong>Setup Screen</strong></td>
<td>9</td>
</tr>
<tr>
<td>Overview</td>
<td>9</td>
</tr>
<tr>
<td>Recipe Graphic</td>
<td>10</td>
</tr>
<tr>
<td>Recipe Editor</td>
<td>13</td>
</tr>
<tr>
<td>Property Editor</td>
<td>16</td>
</tr>
<tr>
<td>Overview</td>
<td>17</td>
</tr>
<tr>
<td>View Mode</td>
<td>18</td>
</tr>
<tr>
<td>Messages</td>
<td>19</td>
</tr>
<tr>
<td><strong>Inspection Recipe Creation</strong></td>
<td>21</td>
</tr>
<tr>
<td>Overview</td>
<td>21</td>
</tr>
<tr>
<td>Starting the Wizard</td>
<td>22</td>
</tr>
<tr>
<td>New Recipe</td>
<td>23</td>
</tr>
<tr>
<td>Board Settings</td>
<td>24</td>
</tr>
<tr>
<td>Load Board (Online Only)</td>
<td>25</td>
</tr>
<tr>
<td>CAD Import</td>
<td>26</td>
</tr>
<tr>
<td>CAD Import – Profile Creation</td>
<td>27</td>
</tr>
<tr>
<td>Board Geometry</td>
<td>33</td>
</tr>
<tr>
<td>Background Image Alignment</td>
<td>35</td>
</tr>
<tr>
<td>Fiducial Setup (Fiducials in CAD)</td>
<td>36</td>
</tr>
<tr>
<td>Fiducial Setup (Fiducials not in CAD)</td>
<td>37</td>
</tr>
<tr>
<td>Define Packages</td>
<td>38</td>
</tr>
<tr>
<td>Verify Recipe</td>
<td>40</td>
</tr>
<tr>
<td><strong>Pre-Inspection Tasks</strong></td>
<td>41</td>
</tr>
<tr>
<td>Recipe Verification</td>
<td>41</td>
</tr>
<tr>
<td>Component Definition</td>
<td>42</td>
</tr>
<tr>
<td>Creating Tagsets</td>
<td>47</td>
</tr>
</tbody>
</table>
# Editing Functions

- Common Editor Functions .......................................................... 49
- Component Editing Functions ....................................................... 49
- Inspection Specific Functions ....................................................... 50
- Tagset Functions ........................................................................... 51
- Library and Package Management Functions .............................. 54
- Search Tool .................................................................................. 56

## Setup for Position Inspection ......................................................... 57

- Overview ..................................................................................... 57
- Location Model ............................................................................ 59
- Location Model – Box In Box ......................................................... 60
- Location Model – Point In Box ....................................................... 60
- Polarity Mark ................................................................................ 61

## Setup for Solder Inspection ............................................................... 65

- Overview ..................................................................................... 65
- TBA Setup Tool ............................................................................ 66
- TBA Compatible Inspections .......................................................... 69
- Setting up a TBA Inspection ......................................................... 69

## Setup for Additional Inspections ...................................................... 71

- Overview ..................................................................................... 71
- Condition Inspection ................................................................. 72

## OCR.................................................................................................. 73

- Overview ..................................................................................... 73
- Adding OCR ................................................................................. 73
- Configuration Dialog ................................................................. 74
- OCR Parameters .......................................................................... 75
- Training Characters ..................................................................... 77
- OCR Training Manager ............................................................... 78
- OCR Tips ....................................................................................... 79

## Macro Inspector ............................................................................ 81

- Overview ..................................................................................... 81
- Adding a Macro ............................................................................ 81
- Configure a Macro ....................................................................... 82
- Macro on Terminals ..................................................................... 85
- Trainable Macro .......................................................................... 86
- OCV Macro ................................................................................ 88

## First Inspection .............................................................................. 91

- Inspection Controls ................................................................. 91
- Inspection Results ....................................................................... 92

## Saving the Recipe .......................................................................... 95

- Save / Save As ............................................................................. 95
- Recipe Certification ...................................................................... 96
Multiboards .................................................................................................. 97
  Multiboard Types ..................................................................................... 97
  Multiboard Structure .............................................................................. 98
  Multiboard Synchronization .................................................................. 102
  Regular Multiboard Definition ............................................................... 103
  Irregular Multiboard Definition .............................................................. 105
  Multiboard Editing .................................................................................. 107
  Multiboard Windowize ........................................................................... 107
  Block Skip ............................................................................................... 108

Barcode Scanning ........................................................................................ 111
  Overview ................................................................................................. 111
  Recipe Setup ........................................................................................... 112
  Barcode Component Setup ...................................................................... 113

Maintenance .................................................................................................. 115
  Overview ................................................................................................. 115
  Test Card ................................................................................................. 116
  Service / Maintenance ............................................................................ 117
  Load the Test Card .................................................................................. 118
  Camera Alignment Check ....................................................................... 120
  Brightness Adjustment Check ................................................................. 120
  Flash Alignment Check ........................................................................... 120
  Flash Level Adjustment .......................................................................... 121
  Grid Adjustment ....................................................................................... 121
Preface

About This Document

This Programmer Guide describes the programming of the Symbion™ range of Inspection Systems.

This guide is organized into chapters each covering a particular aspect of the use or operation of the system.

More detailed information on any of the subjects in this guide can be found in the *Symbion Reference*.

Typography

The following typographic conventions are used throughout this guide:

- Reference to other documents is shown as *Operator Manual*
- Reference within the same document is shown as *Typography*
- Menu items are shown as *File*
- Menu items to be chosen are shown as *File > New*
- Buttons and Icons are shown as they appear in the interface
- User input to be typed is shown as *typing*
- Keyboard short cuts are shown as *Ctrl-C*

Notes to help you use the system are shown like this:

![Note](image)

Remember to save all your work to the database before shutting down the system

Cautions are also given where appropriate:

![Caution](image)

Never operate the system with malfunctioning interlocks.
Prerequisites

Users of the system should fulfill these prerequisites;

- Familiar with the Windows® Operating System
- Familiar with the applicable production environment
- Have a Username and Password for the Operating System
- Have a Username and Password for the Symbion Application
  
  The system administrator will provide Username and Password information

- Be aware of all safety recommendations in the *Operator Manual*
  
  The Symbion is certified inline only.
  
  The Symbion is intended for operation inline, and should not be operated offline with either the Load or Unload aperture open.

- Have received training in the use of the system
System Overview

Symbion Concept

The Symbion S36 is a new generation of Automated Optical Inspection (AOI) Systems.

The system provides exceptional ease of use, with Wizard driven processes following normal Windows application conventions.

The system incorporates database architecture to facilitate distribution of inspection data and experience throughout an organization.
Basic Operation

Starting the System

To Start the Symbion™:

- Locate the Main Power Switch at the rear of the system, turn it to the On ('I') position
- On the Front Panel press the Green button marked 'I'
  
  The computer will begin to boot automatically.

- Once the computer has started you will be prompted to Log In to Windows
  
  Use the Username and Password given to you by the Administrator.

- Double click the AOI Server shortcut on the desktop
- Double click the Symbion S-36 shortcut on the desktop
- The Welcome screen is displayed when the software has started
The Welcome Screen

From the Welcome screen you must first Logon to the system before navigating to other parts of the Application. To Logon;

- Click the round Logon button in the center of the wheel
- In the dialog box enter your Username and Password

![Use the Username and Password given to you by the Administrator.]

The Welcome screen then allows access to those areas of the application your Username and Password permit.

![The larger buttons on the upper part of the wheel provide access to everyday parts of the Application;]

- Setup for creation and maintenance of inspection recipes
- Production for running automatic inspections

The smaller buttons on the lower part of the wheel provide access to less frequently used parts of the application;

- Maintain for maintenance and calibration of the system

![The currently inactive options will be introduced in future versions.]

The currently inactive options will be introduced in future versions.
Inspecting Production

Testing of Inspection Recipes is carried out through the Production part of the application.

To begin inspection of production using an existing recipe;

- Go to the Production screen by clicking the Production button on the Welcome screen
  
  If you have a dual lane system, both tracks are represented in the display below.

- Click the button labeled No recipe, the Recipe Chooser will be displayed
- Select the Recipe from Chooser and click Open
- The Inspection button becomes active, indicating that inspection can begin

If one recipe is used for many variants the Inspection Set must be selected;

- Click the button labeled Default, and select the Inspection Set to be used from the list
- Click the button labeled Inspection, Inspection of the specified recipe will begin

Other functions of the Production screen, including descriptions of each area can be found in the Operator Manual.
Shutting Down the System

To shut down the Symbion™:

- Ensure Inspection has been stopped
- Exit the application by clicking 
  ![Note](Note.png) You will be prompted if any unsaved changes are found.
- Click the Start™ button on the Windows Taskbar
- Click Shut Down Computer
  ![Warning](Warning.png) Wait a few moments for the computer to shut down, removing power before shutdown is complete may result in loss of data. The computer will switch off when shutdown is complete.
- Locate the Main Power Switch at the rear of the system, turn it to the Off ('O') position
Setup Screen

Overview

All programming functions of the system are carried out through the Setup Screen or Graphical User Interface (GUI).

The Setup Screen reflects the board oriented concept of the system, and is made up of the following areas:

- Recipe Graphic ①
- Recipe Editor ②
- Property Editor ③
- Overview / View Mode ④
- Messages ⑤

Navigate to the Setup screen by clicking the Setup button on the Welcome screen.

This is not an exhaustive description of the interface. A complete description can be found in Symbion Reference.
Recipe Graphic

The main graphic editor for the recipe is based on the Background Image, a picture of the entire product to be inspected.

Components and their lands are drawn over this image.

The Recipe Graphic supports:

- Graphic Selection
  With the tool enabled click a component to select, double click a component and all components using the same package will be selected.
• **Graphic Editing of position**

  With the tool enabled click a component to select, hold over the center marker and drag to move the component.

  Holding the Ctrl key whilst making the move operation provides options for Global movement

  A second click on the component center marker changes the function to rotation. To rotate the component hold over the handles and drag.

  Normally the rotation tool operates in 15° steps. Holding the Ctrl key while rotating a component permits free rotation

• **Graphic Editing of component and land dimensions**

  With the tool enabled click to select a component, drag handles to adjust the current dimension. Click the handles to change the dimensions being set.

  The resize tool operates on the following dimensions, cycling through in the following order

  $Body \rightarrow Terminal \rightarrow Land$

• **Measurement**

  With the tool enabled hold to start measuring and drag over the object to be measured. The tool reads out the length measured, its individual X and Y components and the angle.

  This tool also provides brightness measurement, when not using the measurement functionality

  Holding the Ctrl key while using the measure tool will display the current Height of the ROI this is useful for checking Height Synchronization

• **Zoom in / out**

  Click to zoom in or out by one step.

  You can also use the + and – keys on the numeric keypad to zoom. When no component is selected, the zoom operates on the cursor location

• **Zoom to fit**

  Click to zoom the selected component to the maximum level, allowing the whole component to fit in the display.

  You can also use the / key on the numeric keypad to zoom to fit
• **Zoom to extents**
  Click to zoom out to view the entire recipe.

• **Context Menu**
  Right clicking on any selected component presents the context menu. Normal Windows functions, such as Copy and Paste, are provided together with application specific tasks.

The following layers can be displayed on the recipe Graphic:

• **Component Body**
  Draws the component body (blue frame) when active

• **Terminals**
  Draws the terminals (yellow frame) when active

• **Lands**
  Draws the package (magenta frame) and board lands (green frame) when active

• **Tolerance**
  Draws the location tolerance (cyan frame) when active

• **Shadows**
  Draws the component shadows (gray frame or filled area) when active, and an angled light source or camera is selected

• **Region of Interest (ROI)**
  Draws the component ROI (orange frame) when active
Recipe Editor

The Recipe Editor represents the structure of the Inspection Recipe. This is a hierarchical structure based on a logical representation of an Assembly product.

Each part of the recipe has particular properties, which can be manipulated through the Property Editor.

The Recipe Editor has two views, which can be switched by clicking on in the top right of the Editor.

The Table View is the normal editor, and facilitates at a glance checking of defined inspections and inspection coverage.

The columns shown are as follows;

- **Name**, the object name (such as Frame) or the Component Name
- **Tag**, check box to mark/unmark a component from a Tag Set
  - A Tagged component may be considered as a remembered selection, some special operations are only possible on Tagged components.
- **Package**, the name of the Library Package used for this component
  - The choice of Package determines which inspections are possible, as well as the dimensions and characteristics of the component.
- **Check**, the current status of the component this may be a combination of;
  - ![Checkmark] This component is OK and it's package definition matches that defined in the library.
  - ![Warning] This component is OK, but it's inspections differ from those defined in the Library package.
  - ![Information] This component is OK, but it does not exist in the available Library.
  - ![Error] This component is not OK (tool tips will give details of error)
  - ![Macro] A Macro Inspector is present on this component
• Each inspection is then shown according to the following scheme:
  - **Location**, checks the accuracy of the components location
  - **Presence**, checks the component is fitted
  - **Tombstone**, checks for components standing on end
  - **Billboard**, checks for components lying on one side
  - **Flipped**, checks for components placed upside down
  - **Polarity**, checks for correct orientation
  - **Volume**, checks for sufficient solder
  - **Open**, checks for open solder joints / lifted leads
  - **Short**, checks for bridges between terminals or components
  - **OCR**, machine reading of text / barcodes

  Where inspection is possible, an inspection is shown either as ✅ if enabled or ⬜ when disabled.

  Double clicking on the checkbox will toggle the state between on and off.

  When an inspection is activated, but it not supported by any Inspector the inspection is marked with a pink border 🔴.

  After testing the result of the inspection is also indicated, failing inspections are marked with a red border 🔴. See **Inspection Results** for more details.

• Comment, a field containing additional information
The Tree View is a more advanced form of the Editor.

The columns shown are as follows;

- **Tree**, the location in the Tree hierarchy (see *Symbion Reference* for more information)
- **Tag**, as in the Table View
- **RefDes**, the component Name or Reference Designator
- **IdRef**, the name of the particular part of the tree, this may be the Package name, or the name of an Inspection – dependant on the location in the Tree.
- **Check**, as in the Table View

The following columns are all concerned with the display of inspection results.

- **Original**, when working with images shows the original result stored in the image.
- **Verified**, shows the verified result for the component
- **Current**, shows the result of the last inspection carried out

Additional fields can be added to the view, by right clicking the column headers and selecting additional aspects from the list.
Property Editor

The Property Editor allows easy editing of all component properties. The Properties are grouped under Tabs.

- **Component**, contains the original CAD data relating to the component and the Library Package that is assigned.
- **Body**, contains the dimensions and shape information for the component
- **Polarity Mark**, describes the expected Polarity Mark
- **OCR**, describes the checking of printed text on the device
- **Terminals**, contains dimension and form information for the component
  
  The terminal form defines the expected shape of the solder joint.
- **Lands**, contains the dimensions and offsets of the component lands
- **Inspections**, describes which inspections should be carried out
  
  Some inspections have extra parameters in addition to the activation visible in the Table Editor.
- **Alignment**, contains inspectors used for pre-inspection alignment of the ROI, see **Inspectors**
- **Inspectors**, contains inspectors used to carry out the specified Inspections, see **Inspectors**
Overview

The Overview panel always shows the whole of the Inspection Recipe. When working in the Graphic Editor with a Zoom View the Overview shows the current zoomed area in a frame.

Clicking in the Overview panel will cause the Graphic Editor to jump to that area at the current zoom level.

Dragging in the Overview panel will pan the Graphic Editor at the current zoom level.

Clicking on the View Mode tab will display that panel.
View Mode

The View Mode is used when viewing live images. The panel represents all available Light and Camera combinations.

Lights are represented by the Yellow circles. Cameras are represented by the white squares.

The selected light is shown Red the selected camera is shown Blue.

Clicking a light source will cause the live image to show that light direction.

Clicking a camera will cause the live image to show that camera view.

Clicking on the Overview Mode tab will display that panel.
Messages

The messages panel displays the results of inspections. It is also used during recipe verification to list found issues.

The tabs at the bottom of the Messages panel record the last 10 result sets. Selection of a result set will display those results on the Recipe graphic.

Results are shown with the following icons:

- ✔ This component is OK and passed all selected inspections
- ❌ One (or more) of the inspections was failed
Inspection Recipe Creation

Overview

For the creation of new Inspection Recipes a Wizard is provided, when successfully completed the Inspection Recipe is ready for fine tuning with a small quantity of boards prior to use in Production Inspection.

The Wizard may be run on either a machine or an Offline Programming Station.

To create a new Inspection Recipe you will need the following;

- A Symbion S-36 System or Offline Station
- Component Data for the product

Optionally;
- An example of the product after the SMT line
- An unpopulated board
- Additional Data (Multiboard, BOM)
Starting the Wizard

To create an Inspection Recipe using the Wizard:

- Go to the Setup screen by clicking the Setup button on the Welcome screen
- Click the New Recipe button in the Tasks list;

Each step in the Wizard must then be completed before proceeding to the next. The steps are described in the following pages.

As tasks are completed the icon border turns green
New Recipe

The first step in the Wizard creates an empty recipe into which information about the product to be inspected will be added by the following steps.

- In **Recipe Name** type in the name to be used
- Optionally the following may also be provided:
  - In **Recipe Revision** an identifier may be given to differentiate this Inspection Recipe from others with the same name
  - In **Product Name** a more complete Product Name may be given
  - In **Comment** any additional information may be typed

Once complete proceed to the next step by clicking ✅
Board Settings

In this step the physical size of the product to be inspected is defined to the system.

- Choose the Land Finish Type from the drop down list
  The Land Finish may be Gold, Copper or Tin

- In X Size and Y Size enter the dimensions of the Board
  The units in which the dimensions are entered can be set in Measuring Unit

- Click on Set Adapter Width and the rails will be adjusted ready to accept the board (Online Only)

Once complete proceed to the next step by clicking ▶
Load Board (Online Only)

The completed example of the product can now be loaded into the system to capture a Background Image.

- Click Load Board

⚠️ Take care when loading a board manually into the system

Once the board is loaded into the adaptor a Background Image can be acquired.
- Click Acquire Background Image

![Image]

The entire area defined by the Board Size is photographed and presented as a single image in the Graphic Editor

Once complete proceed to the next step by clicking
CAD Import

The manufacturing data of the product is now imported into the empty Inspection Recipe.

The system supports the following data:

- ASCII text
- Placement Data, one component per line including placement data, reference designator and package/part information
- Multiboard Data, describing the orientation and relative position of Miniboards
- Bill of Materials, one part number per line with corresponding package information

To import data first a Profile must first be selected or a new one created. The Profile describes the data format to the system, in order to import the CAD Data successfully.

If you use a consistent format for manufacturing data only one CAD profile will be necessary. If you receive data from many sources, in many formats, it may be necessary to create a new profile on each occasion
CAD Import – Profile Creation

To create a new Profile and begin CAD Import:

- Click New
- Type a name for the Profile in the Field and press Enter
- Select the Profile and click

To re-use a Profile:

- Select the Profile and click

A Clone of an existing profile re-uses all aspects of the profile, this is useful for re-using package links with a different CAD format
• Click the check boxes corresponding to each data type available

- Multiboards
- Components
- BOM
- Gerber

• Click 

[Image of a dialog box with check boxes for Multiboards, Components, BOM, and Gerber]
• In the Chooser select the correct CAD file and click Open
The CAD Import dialog defines how the CAD file should be translated into a recipe, and comprises the following areas:

- The file to be imported is shown as a preview
- Filters are available to manipulate the file
- Delimiter selection
- Function of columns in the Parsed view

The preview and parsed views have tell tales which indicate the state of the translation. Errors are shown with red markers, and warning with yellow markers, clicking a marker will show the problem in the view.
Specify if the file uses a Delimiter or is Fixed Size
  o If a Delimiter is used and Auto fails to identify it correctly select the correct delimiter
  
  If the file is fixed size click on the ruler to add a column marker, once a break is added you can reposition it by sliding the marker

  • Right click each column header in the lower panel and select the function from the list (example is shown for Component Data)

  ![Column Markers Example]

  Additional filters are provided for;

  • Header Lines, ignore a specified number of lines at the top of the file
  • Exclude / Include define a rule for identifying lines to be excluded or included

  ![Exclude / Include Mask]

  The Exclude / Include masks use standard wildcards; * for one or more characters, ? for a single character

  The Exclude / Include masks are case sensitive

  • RefDes Prefix, in any line where the Reference Designator begins with a specified character, that character will be prefixed to the Package Type
  • Begin and End, define markers to be used to identify sections of a file that should be used
The CAD Import dialog

Once complete proceed to the next step (or next data type) by clicking ▶️

If additional files are to be added, you can open a file by clicking the ‘Open’ button in the bottom left corner, and selecting the appropriate file from the chooser.
Board Geometry

Now the format of the CAD data is defined. The component locations will be added to the recipe.

Verify the orientation of the components with respect to the background image.

Within the Geometry dialog the following can be specified

- Units for the co-ordinate data (select inch or mm from the drop down list)
  - Scale for the selected unit (e.g. 1.0, 0.1, 0.01)

- Units for the orientation data (select from degrees or radians)
  - Scale for the selected unit, for example 90 when CAD contains orientations 1, 2, 3, 4.
  - Setting the angle scale negatively (for example -1) should be used when orientation data is Counter Clockwise
• X and Y Offsets will offset the CAD zero by the values specified
• Angle Offset, should be set to ensure the correct orientation of components
• Mirroring, Flipping, Rotation of the entire data is achieved by clicking the orientation marker
  o Clicking the arrow head of an axis will flip that axis
  o Clicking the intersection of the axes will exchange them
  o Clicking in a corner of the board graphic will move the zero to that point

When importing Multiboard data the options are repeated for the Multiboard information.

Once complete proceed to the next step
Background Image Alignment

In this process the background image is corrected to fit the data.

First a component must be selected as an Anchor.

- In the Recipe Graphic select the Move Tool
- Select a component close to one corner of the background image
- Drag the component to the correct location
  
  While a component is selected with the Move Tool the position can be adjusted by holding Alt and tapping the cursor keys in the direction required.

- Once satisfied with the position click

Now a component will be moved and the transform required to make the image fit will be calculated

With the Move Tool still selected
- Select a component close to the opposite corner of the background image
- Drag the component (Hold-M1) to the correct location
- Once satisfied with the position click

The system will now transform the background image to fit the positions identified in the previous steps.

This process does not make any changes to the data, only the background image is manipulated.

Now the Fiducial components need to be identified
Fiducial Setup (Fiducials in CAD)

In this step the Fiducials are identified to the system

- Locate the Fiducial component from the list of packages imported from the CAD file
- Select a suitable Fiducial shape from those available in the right of the panel
- Right click the Fiducial and choose ‘Define Link’
The Fiducials will be listed in the bottom left of the panel.
- Make two of the Fiducials active by clicking the checkbox in the Active column
  The Fiducials should be as far apart as possible, and ideally diagonally opposite.
- Click to continue to the next step
- Click Yes to confirm saving the Fiducial definitions
Fiducial Setup (Fiducials not in CAD)

When Fiducials are not included in the CAD data extreme care must be taken with the previous step **Background Image Alignment**.

If a satisfactory alignment cannot be achieved at this stage (for example no defined packages) add the Fiducials and repeat this step later by clicking at any time.

- Position the Graphic editor so the area to which the Fiducial should be added is clearly visible
- Select a suitable Fiducial shape from those available in the right of the panel
- Drag the Fiducial from the Panel to the Graphic Editor

Use the Graphic editing tools Move / Resize to position and size the Fiducial correctly.

The Fiducials will be listed in the bottom left of the panel.

- Make two of the Fiducials active by clicking the checkbox in the Active column
- Click to continue to the next step
- Click Yes to confirm saving the Fiducial definitions
Define Packages

In this step the CAD packages and part numbers are linked to packages in the Package Library.

A Library Package defines the physical attributes of a component, such as size, type and number of terminals.

The Package also determines how the component will be inspected and for which qualities.

- Select a CAD Package to be defined (link is red) from the list on the right

The components picture from the background image will be shown in the bottom right. In case no component is fitted at that location all components of that CAD Package are listed. Selecting another component causes it to be displayed.
• Use any of the available methods to locate the correct component;

  **Search by Size**
  o Select the resize tool \[\text{ }\] in the component picture,
  o Drag the handles of the yellow frame to fit the component
  o Right click and select Search Similar Packages

  ![Select Options](image)

  Optionally specify the Thickness of the component and/or Terminal Count. Be sure to enable each of these additional parameters used with the check-box.

  o Click Ok

  Library components matching these parameters will be displayed

  **Search by Name**
  o Right click in the component list and select Search CAD Package Type
  o Click OK

  Library components with matching names will be displayed

  **Search by ‘JEDEC’ Parameters**
  o Select the characteristic to filter from the drop down lists on the left (for example ‘Material’)
  o Select the appropriate value (for example ‘Metal’)

    ![Note](image)

    More than one filter can be used, they are used in combination (as a logical AND)

  Library components matching the filter will be displayed

• If a suitable component can be identified right click the Package to be linked, and select Define New link

• If no suitable component is found, a new component can be created. For details see **Component Definition**

• Repeat until all possible Packages have been linked

• Click \[\text{ }\] to continue to the next step

• Click Yes to confirm saving the Package links
Verify Recipe

The last step in the Recipe Creation Wizard is the verification of the recipe. In this step the result of the Wizard is checked for errors and missing steps.

- The dialog shows a summary of the results, any issues found are listed in the messages panel of the Setup screen
- Click $\square$ to Windowize the Recipe, and click OK in the following dialog

- Click $\checkmark$ to end the Wizard

The wizard is now complete; before testing can begin any issues found by the Verify Recipe stage should be completed.
Pre-Inspection Tasks

Recipe Verification

Errors found by the Verify stage of the Wizard must be rectified. The current verified state of the Recipe is always shown in the toolbar by the icon indicating the recipe is OK (with a green tick) or has errors (with a red cross).

The Recipe can be verified at any time by clicking the button .

The Verification process checks for the following;

- That all components have been linked. ‘Unassigned component’ shows for each component not linked.
- That the structure of used packages is valid. Messages such as ‘Format Terminals’ will be given according to the particular error
- That all specified Inspections are possible. The Message ‘No Inspector for…’ will be displayed
- That any configuration options that may affect performance are set correctly.

A full list of possible messages can be found in the User Reference.

Clicking any message generated by the Recipe Verification will select the component, or recipe element, in which the problem was found.
Component Definition

The problem most often identified by the Recipe Verification is undefined components.

These components must be defined before inspection can be carried out.

To define a component;

- Select an undefined component
  - You can also select undefined components directly from the Recipe Verification report – just click the message in the list.
- Right click , and select Define Package from the context menu

The Component Definition dialog is displayed,
• Select the most suitable package family from Array, Discrete or IC and click the **Next** button

![Image](image.png)

In this example we will define a chip capacitor, so the first selection should be **Discrete**

• Select the most suitable category in each following dialog

![Image](image.png)

Your selection is [Discrete - Chip - Chip Capacitor]  
Some additional information is required. Please select below.

- Chip Capacitor  
  Capacitors are usually light in color and have terminals that enclose the end of the component.

- Chip Resistor  
  Resistors are usually dark in color and have terminals wrapped around the end of the component.

With each selection the visible Library packages will be reduced. You can click any package at any time to see it used in your recipe.

• Enter the number of terminals (not for discrete components) and click **Search**, click the **Next** button

• Set the size in the Recipe Graphic, and click **Search**, click the **Next** button
At this point you must assign an existing component or create a new one,

- If a good match was found select Yes, otherwise select No, and click the Next button
If no good match was found the system will create a template from the information provided about the size and number of terminals of the package. The Industry Name to be used will be pre-set as that used in the source CAD file.

Once the component is properly defined in the Recipe Graphic click Create.
The new package is created in the Library. You must select how to update the recipe.

You can choose between updating by the CAD part number, or the CAD Package.

- Once you have made your selection click Finish
Creating Tagsets

A Tag Set is a stored selection. The system supports many editing operations based upon these stored selections.

Tag Sets may be grouped together to form Inspection Sets. These can be used to create variants within the recipe.

Tag Sets and Inspection Sets are accessed through the drop down in the toolbar.

Inspection Sets are marked with ☐ and Tag Sets are marked with ☑.

To create Tag Sets automatically for each family or (Type) of components, click Edit Inspection Sets.

The Inspection Set Editor is displayed.

Inspection Sets are shown on the left, with Tag Sets on the right.

Click the button ☐ to create a Tag Set for each Type of component.

Click the button ☑ to create a Tag Set for each Package used.
Editing Functions

Common Editor Functions

The editor supports regular Windows® functions including:

- Cut the selection to the clipboard
- Copy the selection to the clipboard
- Paste the selection from the clipboard
- Delete the selection

These functions, in addition to more system specific editing tools can be accessed from the main menu Edit or through the context menu.

The context menu will contain all applicable editing functions for the current selection.

Where standard Windows® functions are used the standard keyboard shortcuts are also employed.

<table>
<thead>
<tr>
<th>Function</th>
<th>Shortcuts</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cut</td>
<td>Ctrl - X</td>
</tr>
<tr>
<td>Copy</td>
<td>Ctrl - C</td>
</tr>
<tr>
<td>Paste</td>
<td>Ctrl - V</td>
</tr>
<tr>
<td>Delete</td>
<td>Delete</td>
</tr>
</tbody>
</table>

Component Editing Functions

Functions provided for component editing include;

- Insert into a component structure, may be used to manually add Pinset, Polarity Mark etc.

  It is preferred to use the Property Editor or Component Definition Tool to modify a component.

- Clone the component, this command will produce a copy of the selection. The copy of the component will be automatically named ‘_copyn’

- Format Terminals, this command organizes the component Terminals into the correct order.

- Set Default ROI, resets any existing component ROI (Region Of Interest) to the default.

  Commands such as Format Terminals and Set Default ROI are only required when components have been manually constructed.
Inspection Specific Functions

Inspection specific editing functions may be applied at component level or higher.

Using any of these functions can cause any fine-tuning of Inspections to be lost. Exercise Caution.

- Clear Inspections will remove all existing inspections from the selection
- Set Default Inspections will reset all existing inspections in the current selection
  
  Inspections will be reset according to the Inspections defined as default in the Inspection Config

- Set Package Library Inspections will reset all existing inspections according to the current definition of the package(s) used in the current selection

- Set Simple Inspections will reset all existing inspections, replacing them with empty tests
  
  Set Simple Inspections ONLY if you intend that the component(s) selected should NOT be inspected. No component will fail for any reason with Simple Inspections

- Fix Inspections will attempt to correct any issues found with the defined Inspections
Tagset Functions

Some editing functions can be carried out on multiple selections or Tagged components.

A selection of Tagged components can be stored in a Tagset.

See Creating Tagsets

The following editing options are in the Tag menu.

- Manipulate Tagged Component Common Properties will open a dialog containing all editable properties.

To edit a property locate it in the tree. Changing the Value will change all tagged components.

A Common Property is one that exists and has the same value in all tagged components.
Manipulate Tagged Component Value will open a dialog containing all numerical properties.

To edit a property select it from the Value list on the left.

A Histogram shows the distribution of the current values.

Enter the new value, correction or factor in the Value: field.

Click on Set† to set the value of all tagged components to the specified value.

Click on + to apply the correction to all tagged components

Click on x to apply the factor to all tagged components

This tool is very useful for manipulating positions of all components simultaneously.
• **Tag Package Report** generates a report in the Messages panel of the content of the current Tagset.

This list is interactive; selecting any package on the list selects all matching packages.

A context menu on each package offers the possibility to Tag the components for further editing.

This tool makes it very easy to work through a recipe fine tuning each package in turn.
Library and Package Management Functions

Editing functions are provided to manage Packages used in the Inspection Recipe.

Where the check field indicates a difference between the package in the recipe and the version stored in the Package Library the following functions are available;

- Get Latest Package From Library will replace the Package used in the selected component with the latest version from the Package Library

- Update Package in Library will replace the Package in the Library with the version present in the Inspection Recipe

When either option is selected you can choose how the update should be applied.

You can choose to update;

- Selected Component will replace only the selected component with the update from the library
- Same Package will replace all instances where this Library Package is used
- Same CAD Reference will replace all instances where the CAD package is the same as the selected component

The dialog shows how many components will be affected by this operation.
You can then choose what to update;

- **Inspections** will update only the Component Inspections with those from the Library
- **Component Definition** will update the Component geometry (with the exception of lands) from the Library
- **Landing Definition** will update only the Lands from the Library

Warnings will be generated if the selected combination cannot be carried out, for example if the Component Definition is updated, and the Pin pitch is changed in the Library the Landing Definition cannot be preserved.

The same mechanism is employed when drag-and-drop Package updates are made from the Library and when using Tag > Synchronize.
Search Tool

A powerful search tool is provided to assist the editing of Inspection recipes, the Find Component dialog is accessed either through the menu Search > Find Component or by keyboard shortcut, Ctrl + F.

The tool searches for the specified text in one of the following areas;

- Reference Designator, searches in the component name
- Type, searches for components with an Inspection Type matching the specified text
- Package, searches for components where the Library Package used matches the specified text
- CAD Package, searches for components where the Package specified in the CAD source matches the specified text
- CAD Part No, searches for components where the Part information specified in the CAD source matches the specified text
- Comment, searches for components where the Comment matches the specified text
- Id, searches for components with a specific ID

A wildcard (*) is supported in the Search Text

The default action of the Tool is Find, the first match found is selected and the tool closes. The tool can also Select All or Tag All components matching the search text.

Once a search has been performed the keyboard shortcuts F3 and Shift + F3 can be used to find the next match, or previous match.
Setup for Position Inspection

Overview

The Property Editor provides a tab for Position inspections. In most cases setup of the inspections is as simple as activating those required.

Inspections requiring more detailed setup are described in following sections.

Possible Position inspections are;

- ![Location](image) Location, reports an error when the component is detected as improperly placed.
  
  Inspection is on or off, and criteria for correct placement are determined by the Location Model.

- ![Presence](image) Presence, reports an error when the component is detected as not fitted.
  
  Depending on the Inspection Type the Presence error may also be reported together with Billboard and Tombstone.
  
  Inspection is on or off, no other setup is required.

- ![Billboard](image) Billboard, reports an error when the component is detected as being placed on its side.
  
  Inspection is on or off, no other setup is required.

- ![Tombstone](image) Tombstone, reports an error when the component is detected as being placed on one end.
  
  Inspection is on or off, no other setup is required.

- ![Flipped](image) Flipped, reports an error when the component is detected as being placed upside down.
  
  Inspection is on or off, no other setup is required.
• 🔍 Polarity Mark, reports an error when the component is detected as being incorrectly oriented.
  Inspection is on or off, criteria for inspection are defined by the **Polarity Mark** tab of the Property Editor.

• 🔄 Pin Presence, reports an error when the end terminals of the component are not detected.
  Inspection is on or off, no other setup is required.

  ![An Inspection which is switched on is indicated by ☑. To turn off an Inspection click the checkbox, the off state is indicated by □.](image)
Location Model

The Location Model defines the rules to be applied when assessing the placement accuracy of the component inspected.

The Location Model may be one of two types; Box in Box and Point in Box.

The Location Model is defined through the Property editor, in the Model parameter of the Location inspection.

To select a Location Model;
- With a component selected, click on the Inspections tab in the Property Editor
- Click the expand icon by the Location item
- Double click the Value drop down and select from the options

- **Box in Box 2D**
  - Use the Box in Box method with a user defined percentage off pad allowance
- **Box in Box 2D Class 1**
  - Use the Box in Box method with an off pad allowance according to IPC Class 1 (50% off the land)
- **Box in Box 2D Class 2**
  - Use the Box in Box method with an off pad allowance according to IPC Class 2 (50% off the land)
- **Box in Box 2D Class 3**
  - Use the Box in Box method with an off pad allowance according to IPC Class 3 (25% off the land)
- **Point in Box 2D**
  - Use the Point in Box method with user defined X, Y and Angle tolerances
- **None**
  - The Location of the component will not be controlled

**Warning**

If the Location Model is set to None then regardless of the accuracy of placement provided the component is fitted it will pass.

**Tip**

Box in Box Location Models are not available for Inspection Types without terminals, for example BGA
Location Model – Box In Box

The Box in Box Model depends upon the allowed positions of the terminals relative to the defined lands.

The allowed positions for the landings are calculated (in this example the terminal is allowed to be up to 50% off the land).

The resulting ‘bounding box’ is then compared to the found position of the component body.

Provided the found body position is within the determined ‘bounding box’ then the Location test will pass.

Location Model – Point In Box

The Point in Box Model compares the expected centroid of the component with the found centroid.

The defined tolerance (for example +/- 0.2mm) is applied in X and Y about the centroid, creating a box.

The resulting box is then compared with the centroid of the found component position.

If the found centroid is within the defined box then the Location test will pass.
Polarity Mark

The Polarity Mark tab defines the expected marking to the system.

To define the polarity mark type;

- With a component selected, click on the Polarity Mark tab in the Property Editor
- Double click the Mark Type drop down and select from the options;

<table>
<thead>
<tr>
<th>Mark Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bright Line</td>
<td>A line brighter than the background, indicating the polarity of the device</td>
</tr>
<tr>
<td>Chamfer</td>
<td>A sloping edge, on the side of the device carrying Pin 1</td>
</tr>
<tr>
<td>Corner Chamfer</td>
<td>A sloping edge on the corner of the device nearest to Pin 1</td>
</tr>
<tr>
<td>Corner Flash</td>
<td>A plated mark on the corner of the device nearest to Pin 1</td>
</tr>
<tr>
<td>Dark Line</td>
<td>A line darker than the background indicating the polarity of the device</td>
</tr>
<tr>
<td>Dimple</td>
<td>A mark in the surface of the device with a rounded profile</td>
</tr>
<tr>
<td>Flat Hole</td>
<td>A mark in the surface of the device with a square profile</td>
</tr>
<tr>
<td>Laser Etched</td>
<td>A line etched on the component indicating the polarity of the device</td>
</tr>
<tr>
<td>Notch</td>
<td>A cut out indicating the polarity of the device</td>
</tr>
</tbody>
</table>
Selecting None will de-activate the Polarity testing

When the Mark Type is set the system automatically defines a standard size and position for the mark.

If necessary re-size and reposition the polarity mark;

- Select all the component
- Select the Select Tool from the Toolbar
- Whilst holding Shift select the mark by clicking inside it
  A selected sub-component is shown in dark red
Select the Move Tool from the Toolbar

• Position the Mark so that it covers the Polarity Mark on the Device

• Select the Resize Tool

• Drag the Handles to resize the Mark so it fits the Polarity Mark on the Device

It is necessary that the defined mark covers the Polarity Marking on the device, however very accurate definition is not required

If all devices of the same package use the same polarity marking the Update Package in Library function will set the same Polarity definition for all components using the package.
Setup for Solder Inspection

Overview

The Property Editor provides a tab for Solder inspections. In most cases setup of the inspections is as simple as activating those required.

Tools are provided for more detailed setup of all Solder inspections.

Not all inspections described will be possible for all Inspection Types

Possible Solder inspections are:

- Solder Volume, reports an error when the solder joint is detected as having insufficient or excess solder volume.
  Inspection is on or off, the performance of the inspection may be tuned using the TBA Setup Tool.

- Solder Open, reports an error when the solder joint is detected as having open solder joints.
  Inspection is on or off, the performance of the inspection may be tuned using the TBA Setup Tool.

- Short Circuit, reports an error when the terminal is detected as being shorted with its neighbor.
  Inspection is on or off, the performance of the inspection may be tuned using the TBA Setup Tool.
TBA Setup Tool

Tuning of Threshold Based Inspectors (TBA) is carried out through the TBA Setup Tool.

The TBA Setup Tool provides transparent setup of TBA parameters. Any change in a parameter is evaluated immediately without re-testing. The effect of the change is shown graphically.

The tool can be used for setting up the following types of inspection:

- Solder Volume
- Solder Shape / Lifted Lead
- Short Detection

The tool is accessed through the Recipe Editor Table View, by right clicking a suitable inspection and selecting configure from the context menu.
The TBA Setup Tool comprises the Inspection Graphic and a Tab for each Inspection Method.

Within each Tab, the Inspection thresholds are represented by a slider.

![Slider Example](image)

Each slider displays:

- The name of Threshold, in this example ‘M1 offset threshold’
- The Measured value, this is represented by the marker
- The Inspector setting, this is represented by the marker
- The slider is colored for good and bad values.
- An undo button which resets the slider to the start position

The slider is reset to the position it was in when the setup tool was opened.

The effects of moving the slider will be shown interactively in the Inspection Graphic.

The Graphic shows:

- The image used in this Inspection Method
- The area(s) analyzed which are drawn good and bad accordingly
- Some inspections will show a binarized image
- Some inspections will show a chart

![Graphic Example](image)

Once appropriate Inspection settings have been found the Setup Tool can verify the settings.

The verification is carried out against stored examples of good and bad components in the Image Library.
The Toolbar button will trigger a check of these settings. The results are displayed in the messages panel.

![Messages Table]

The Performance Check shows the following performance measurements;

The Number Tested the number of images used in the comparison

- The more images tested the more reliable the analysis can be expected to be

The number of Good Joints with original values and the new settings

- Original values refers to the result stored with the images, the result with the new values is compared to this.

The number of Bad Joints with original values and the new settings

The number of Escapes with original values and the new settings

The number of False Alarms with original values and the new settings

In the Change column the difference between the original, verified result and the result with the proposed values is shown.
TBA Compatible Inspections

The following inspections are compatible with the TBA Setup Tool.

- Solder Volume, checks for sufficient solder
- Solder Open, checks for open solder joints / lifted leads
- Short, checks for bridges between terminals or components

A suitable TBA inspector must also be available, more information on Inspections and Inspectors can be found in Inspection Config

Setting up a TBA Inspection

To set up a TBA Inspection using the Setup Tool;

- Select the component
  - A board is required in the machine for these steps.
- Acquire an image of the component
- From the Recipe Table View right click the Inspection to be set-up
  - The Recipe Editor views can be switched by clicking in the top right of the Editor.
- From the context menu select configure
  - If no context menu is available this indicates that a suitable Inspector is not available. You can check the Inspection Config

The TBA Setup Tool will open, for each Tab in turn;

- Check the displayed result
- Adjust parameters to achieve the desired result on the sample
- Click to check the settings against the Image Library
- Check the Performance Summary to see that the results are good
- Choose to Update the Recipe, or both the Recipe and Library
  - If you do not wish to update, close the Tool with or Cancel
Setup for Additional Inspections

Overview

The Property Editor provides a tab for Other inspections. In most cases setup of the inspections is as simple as activating those required.

Tools are provided for more detailed setup of all Solder inspections.

Possible Other inspections are;

- 🌼 Condition, reports an error when some component specific, qualitative defect is detected.
  Inspection is on or off, the particular functionality available depends on the Inspection Type.
- 📜 OCR, reports an error when component legend does not match that specified during setup.
  Inspection is on or off, and is setup using the OCR Config Tool.
Condition Inspection

Component condition inspection is possible for CHIP_CAPACITOR and CHIP_RESISTOR inspection types.

Availability and functionality of Condition inspectors are described in the table:

<table>
<thead>
<tr>
<th>Inspection Type</th>
<th>Inspector</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>chip.oxidcaps.hk</td>
<td></td>
<td>Checks for oxidation of the component end caps</td>
</tr>
<tr>
<td>CHIP_CAPACITOR</td>
<td>chip.typecheck.hk</td>
<td>Ensures the correct type is fitted and that a Capacitor is not replaced with a Resistor or vice-versa</td>
</tr>
<tr>
<td>CHIP_RESISTOR</td>
<td>chip.solderball.hk</td>
<td>Checks around the component for solder balls</td>
</tr>
</tbody>
</table>

These Inspectors are not added as part of Set Default Inspections, and have to be set up manually.

To set up a condition inspection;

- Select the component to be set up
- In the Property Editor click the Inspectors tab
- Right click the Inspectors tab and choose Add Inspector
- Double click the Undefined inspector and choose the required inspector from the list
OCR

Overview

The Symbion Optical Character Recognition (OCR) Engine has excellent initial detection capabilities.

In cases where the text cannot be read directly by the OCR engine unknown characters are Trained, and Fonts may be created for use with particular vendor or device types.

A comprehensive easy to use configuration panel is provided for setup of the OCR.

Adding OCR

To add OCR to a component:

- Select the component on which the macro should be set up
- In the Property Editor click the OCR tab
- Double click None in the Type field and select from Black on White, White on Black or Laser Etched

The system automatically defines the OCR inspection area as approximately 90% of the body size, centered on the component centroid

- Click

The OCR Config / Train Dialog Opens;

- Configure the OCR (see Configuration Dialog)
- Click OK when complete
Configuration Dialog

To configure OCR Inspection of a component;

The dialog is made up of the following areas;

- **Processed View 1** of the OCR Inspection Area
  
  For best results this image should be clear and legible with a minimum of noise, settings are available to tune this image.

- **Lighting Panel 2** defines the light source(s) to be used
  
  When the dialog opens an automatic light source and camera selection is used to produce the processed image.
  
  Clicking any light source and camera combination will use that source (see **View Mode** for more information)
  
  More than one light source may be selected; the images are combined by the system.
  
  Buttons are provided for commonly used lighting combinations.

- **OCR Parameters 3** defines the behavior of the OCR Engine
  
  Each parameter is described in **OCR Parameters**

- **Result Panel 4** displays the output of the OCR Engine
OCR Parameters

The following parameters controlling the OCR Engine are available;

- **Expected Text** defines the text to be read from the OCR Inspection Area, the text may be entered using wildcards (* ?)

  Regardless of the text entered in Expected Text if the Minimum Length or Maximum Length conditions are set and not met the Inspection will fail.

- **Type** describes the marking type, as Black on White, White on Black or Laser Etched

  The chosen Type determines the default lighting used initially

- **Filter** can be set to apply a filter to the processed image prior to reading.
  Two Filter types are available, Blur and Median each may be applied with a factor from 1 to 4
  Filters can be used to improve contrast in the processed image.

- **Brightness Offset** will manipulate the processed image
  When the offset is 0 the image is processed automatically. Setting an offset can reduce noise in the image.

  The offset may be both +ve and −ve

- **Orientation** determines the direction (relative to the component) in which the text should be read.
  Setting default the system reads the text from the component orientation.

- **Dust Size [mm]** defines the smallest object that may be read as text.
  Setting 0 the system attempts to read all objects.

  Use the ruler to check the size of objects in the processed image

- **Max Char Size [mm]** defines the largest object that may be read as text.
  Setting 0 the system attempts to read all objects.

- **Min Font Aspect Ratio [%]** and **Max Font Aspect Ratio [%]** define rules for the ‘shape’ of characters.
  Setting 0 the system attempts to read all objects.

  The Aspect Ratio is calculated as Width / Height
• **Max Unrecognized Chars** defines the number of characters that may not be read in any given Expected Text.

  Setting 0 the system attempts to read all objects.

  ![Note](image)

  Max Unrecognized Chars is not compatible with the use of wildcards (*) or (?) in Expected Text.

• **Case Sensitive** when on (with check box) the Expected Text is case sensitive.

• **Use Plausible Pairs** when on (with check box) the read text is compared to the Expected Text and allowance is made for defined pairs of characters.

  ![Note](image)

  Plausible Pairs may be reviewed and defined in the OCR Training Manager.

• **Minimum Length** defines the minimum expected length of the read text, if fewer characters are found the inspection will fail.

  Setting 0 no Minimum Length is required.

• **Maximum Length** defines the maximum expected length of the read text, if more characters are found the inspection will fail.

  Setting 0 no Maximum Length is required.

  ![Note](image)

  The value of both Minimum and Maximum Length includes unrecognized characters (which are shown in the result as ~)

• **FontId** defines the font to be used for trained recognition.

  When no FontId is set, no trained recognition will be carried out (see Training Characters).
Training Characters

Any characters that are unrecognized by the OCR Engine may be trained. During Training a FontId is created, that may be re-used for subsequent inspections.

To train a character;

- In the FontId field double click to select an existing font or type in the name to be used to create a new font

  Fonts once created may be reused in any recipe. It is useful to name the fonts for the device vendor

- Select the character to be trained

- Right click, and select Train from the context menu

- In the dialog enter the text to be read for this character

  For symbols, such as © multiple characters may be entered, such that this is read as (c) or copyright

To manage Fonts;

- Click on Train Manager

The Training Manager opens (see OCR Training Manager)
OCR Training Manager

Each FontId that is created is shown as a tab in the OCR Training Manager.

![OCR Training Manager](image)

The Training Manager supports the following functions:

- Create a new Font
  Enter the name to be used in the dialog and click OK to create the Font.

- Save all Fonts to the database

- Review and edit plausible pairs
  Displays a list of plausible pairs, the list can be updated in the dialog by clicking and editing the fields

- Display information for a specific character

- Analyze the stored examples with the standard engine
  Characters correctly recognized by the OCR Engine (without training) are marked Green. Unrecognized characters are marked red, characters for which a plausible pair exists are marked yellow.

- Verify the recognition of an individual character
  Analyzes an individual character.
OCR Tips

The following tips are offered to get the best performance from the OCR Engine;

• The OCR Inspection area should be defined as small as possible to avoid any disturbing features (for example pin ends, polarity marks). These features can make the inspection inconsistent during production inspection.

• For laser etched text use all Flat Diagonal lights to achieve the best contrast, for standard prints Diffuse is normally best.

• Before manipulating any other parameters or training any characters ensure the best possible contrast by adjusting the Brightness Offset and Lighting.

  Use the Acquire button to check any adjustments to Brightness Offset or Lighting give a stable result.

• Once the best contrast is achieved apply filters and other parameters as necessary, and only then train un-recognized characters.

  Changing parameters can affect the thickness of characters and training these characters too early will not be useful.
Macro Inspector

Overview

The Macro Inspector is a powerful tool for creating inspections in addition to the provided inspectors.

Any Macro is based on analysis of user defined areas, and comparison of these areas with one another or some threshold.

Up to three Macro Inspectors can be added to each component, once added to a package the Macros will be stored if the Package Library is updated.

Adding a Macro

To add a macro inspector to a component:

- Select the component on which the macro should be set up
- In the Property Editor click the Inspectors tab
- Right Click the Inspectors tab and select Add Inspector
- Double Click the Undefined Inspector and select one of the macro inspectors

The inspectors macro.1, macro.2 and macro.3 are identical. The names facilitate the use of three macros on one component.
Configure a Macro

To configure a macro inspector on a component:

- In the Inspectors tab, click on the inspector and open it by clicking on ✰
- Select the Defect to be reported when the test fails

Only Inspections supported by the Inspection Type of the component are available.

- Click the Open Config Dialog button
• Add an area for analysis by clicking in the Area panel (middle of the right side)

• Once the area is added;
  o Choose the lighting to be used
  o Choose the operation from the Op field of the Area panel
    Minimum Returns the minimum brightness value
    Maximum Returns the maximum brightness value
    Mean The sum of all pixel values, divided by the number of pixels measured
    Median The brightness value below which half the measured pixels fall
    StdDev Returns the standard deviation (measure of spread of values)
    Pixel Ratio Returns the ratio of pixels between a pair of values specified in Pars
    Relative Pixel Ratio Returns the ratio of pixels between a pair of values specified in Pars offset by the Mean
    Trainable Returns the certainty of a match with learned examples, see Trainable Macro
    OCV Returns the certainty of a match with a learned example of text, see OCV Macro
  o Move or Resize the area as necessary

If the area is resized, any subsequent area added will be the same size initially.
• If you wish to compare a single area to a threshold; enter the area name, operator and threshold in the expression editor

\[ $1 > 10 \]

Areas are identified sequentially as $1, $2, $3, ....

For simple thresholds, common operators are $<$, $>$, $==$.

The result is indicated as true or false.

• More complex inspections will require more areas, expressions can then be used to evaluate one area in comparison with another;

\[ $1 > $2 \\
   (\$1 - \$2) < 10 \]

• Clicking \( \text{in the Expression panel (bottom of the right side)} \) creates an expression (called \#1) which can then be defined in the Expression field.

Use expressions to evaluate the Inspection in smaller parts, and to reduce the length of the main expression.

• Click OK when complete.
Macro on Terminals

When the chosen Defect is terminal oriented:

- Pin Presence
- Solder Volume
- Solder Open
- Short Circuit

Any areas defined will be applied to all terminals.

When working with terminals, they are colored for result. Green for good, and Red for bad.
Trainable Macro

When good and bad samples are available a Trainable area can be added; For a trainable macro to return a result both good and bad examples must be trained.

To setup a Trainable macro

- Select Configure from the context menu

- Create a new Model by typing a name in the dialog and clicking OK
  - Existing models can be selected from the drop down list.

- Train a good example by selecting Train as good from the context menu
- Train a bad example by selecting Train as bad from the context menu
- Create an expression to evaluate the result of the Model

Models return a certainty in the range 0 (absolutely bad) to 1.0 (absolutely good) a result of \(-\infty\) means the model cannot be evaluated.
To manage Trainable models

- Select Activate Train Manager from the context menu

The Macro Training Manager displays all stored Images in Good and Bad categories.

- Other models may be reviewed by selecting them from the drop down list

The following functions are supported:

- Revert the Model to the last saved version
- Delete the selected Image
- Train and Save the Model in this state

Once the model has been Trained and Saved it is not possible to Revert to an earlier version
OCV Macro

The Macro may be used to perform Optical Character Verification (OCV) in which the text to be inspected is compared with a stored image.

To setup an OCV macro

- Add an OCV area to the Macro
- Select Configure from the context menu

- Select the Font ID to be used
  
  This will use the same Trained font as OCR

- Enter the Char to correspond with this image
  
  This can be one or more characters, space is not allowed
• Select Train from the context menu
  This can be one or more characters, space is not allowed

![OCV train window]

• Enter the text contained in the area and click OK
  An image will be added to the Font ID as this text

• Create an expression to evaluate the result of the match
  The result is a measurement of the match between the stored example and that of the inspected component

To manage the stored examples;
• Select Activate Train Manager from the context menu
  The Train Manager is common to the OCR engine, see OCR Training Manager for more details
First Inspection

Inspection Controls

Inspection is controlled by buttons on the Toolbar, available inspection functions are;

- Acquire Selected Component drives to the location of the selected component and makes a picture
- Inspect Selected Component inspects the currently selected component, an image must have been previously acquired
- Acquire and Inspect Selected Component drives to the location of the selected component and makes a picture, the inspection is then carried out
- Inspect Current Window inspects all the components contained within the same window as the selected component, using the Inspection Manager
- Inspect Current Selection drives to the location of the selected component and makes a picture, using the Inspection Manager
- Inspect Active Tagset inspects all the components contained in the current tagset, using the Inspection Manager
- Inspect Recipe inspects the entire recipe, using the current Inspection Set

Click the button to carry out the inspection.
Inspection Results

When an inspection is carried out the results of the inspection are recorded in the Messages view, the Recipe Editor, and the Recipe Graphic.

Errors marked in the Recipe Graphic are shown as circles.

The results recorded in the Messages view, can be re-displayed at any time by selecting the appropriate Tab.

The Editor, Messages and Graphic are interactive. Selecting a component in one, will cause it to be selected in the others.
The Table View of the Recipe Editor indicates defects with red boxes around the individual inspections.

![Image of Table View]

The Recipe Editor views can be switched by clicking in the top right of the Editor.

In the Tree View it is possible to see which part of the component generated the defects.

Defects are indicated by the respective icons, these can be reviewed in the section **Recipe Editor**.
Saving the Recipe

Save / Save As

The first save of the recipe to the database after creation requires the location to be chosen and a name for the recipe to be provided.

To save the recipe, use any of the following;

- Click 🔄 on the button bar
- Choose File > Save (Ctrl + S)
- Choose File > Save As (F12)

- From the Recipe Tree choose a folder in which to store the recipe, or create one by clicking 📄 and entering a name in the dialog
  - The new folder is created under the selected folder
- In the field Recipe name enter the name to be given to the recipe
- Click Save
  - The first save may take some time depending on the size of the board
Recipe Certification

Before a recipe can be used in production it must undergo certification, this process ensures that operators only have access to recipes which are released to production.

To certify a recipe:

- Check the recipe verification is good 🔄 (see Verify Recipe)
  - A recipe that still contains errors detected by Recipe Verification cannot be certified.
- Choose File > Certify Recipe (Ctrl + Alt + S)

- Confirm the Recipe to be saved is correct and click Save
  - The recipe may continue to be edited but changes will be unavailable to Production until the new version is certified.
**Multiboards**

**Multiboard Types**

Multiboards may be defined as either;

- Regular, the boards are spaced at regular X / Y intervals with the same orientation

- Irregular, boards may have inconsistent spacing or employ different orientations

Different procedures are required for creating different types of Multiboard; each of these is described below.
Multiboard Structure

It is important to understand how the structure of a Multiboard is reflected in the recipe.

The intention of the recipe structure is to represent the actual design of the product to be inspected as accurately as possible.

Correct recipe structure will aid the tracking of production data in the Yield Advisor tool. It will also

The recipe structure contains 3 key parts when considering Multiboards;

- Frame describes the object inserted into the machine, this may be the same as the Board itself, or the additional bulk of a carrier.

![Frame Diagram]

- Board describes the single manufacturing unit, this may be assembled in a Frame, and can contain Miniboards.

![Board Diagram]

- Miniboard describes the single repeating, functional unit. These are contained within the Board.

![Miniboard Diagram]
When a Multiboard structure is created by the wizard (Multiboard data available) the elements of the recipe will be correctly organized.

Very often CAD data does not include such Multiboard information and the Multiboard setup must be done manually.

To ensure that the recipe will have the correct structure check the following before beginning to define the Multiboard.

- The Frame size should be defined as the object loaded into the machine. The Frame size is set during the Recipe creation Wizard and shouldn't need to be changed. If it is necessary, select the Frame in the editor and modify using the Property Editor.

- The Board size should be defined as covering all inspected parts. If it is necessary to change the Board size follow the instructions below.
  - Select the Board (graphically or in the Recipe Editor)
  - Select the Resize Tool
  - Drag the Board handles to include all Miniboards

- Create a Miniboard inside the board.
  - Select the Board (graphically or in the Recipe Editor)
  - Insert a Miniboard from the Menu, Edit > Insert > Miniboard

The Insert menu is also available from the context menu. The context menu is accessed by right-clicking an object.
• The Miniboard size should be defined for the single image. If it is necessary to change the Miniboard size follow the instructions below.
  o Select the Miniboard (graphically or in the Recipe Editor)
  o Select the Resize Tool
  o Drag the Board handles to the first Miniboards

![Diagram of Miniboard](image1)

• Optionally the Miniboard shape can be defined for the single image. Defining the Miniboard shape will have no effect on the system performance. It does improve the clarity of the display of defect information to the Repair Operator. To define the Miniboard shape follow the instructions below.
  o Select the Miniboard (graphically or in the Recipe Editor)
  o Select the Resize Tool
  o Click on the Resize handles to change to Polygon Mode
  o Right Click at any location where you wish to add a point to the polygon and choose ‘Add Vertex’
    A Vertex is a point where two lines forming a polygon meet.
  o Any Vertex may be repositioned by clicking and dragging to the desired location.
• The Components must then be copied from the Board to the Miniboard. This step is most easily achieved in the Table View of the Recipe Editor, click to switch between the Tree and Table Views.
  o Select all the components in the Board (graphically or in the Recipe Editor)
  o Cut the components, Edit > Cut
    The components will not be removed until a destination is specified. This feature prevents accidental loss of data in the cut and paste buffer.
  o Select the Miniboard and Paste, Edit > Paste
Multiboard Synchronization

Synchronization of Multiboards is achieved by either;

- **Global Fiducials**, where one pair of Fiducials on the Frame or Board are used to synchronize all Miniboards.

  ![Global Fiducials](image1)

  This method is recommended when the Step and Repeat is defined by data or drawing. Inspection time will be slightly faster with this method.

- **Local Fiducials**, where each Miniboard has its own Fiducials.

  ![Local Fiducials](image2)

  This method is recommended when the Step and Repeat is unknown and has to be found manually. Inspection time will be slightly slower with this method.

To setup a recipe with Global Fiducials;

- This step is most easily achieved in the Table View of the Recipe Editor, click to switch between the Tree and Table Views.

- **Select the Fiducials** (graphically or in the Recipe Editor)

  ![Select Fiducials](image3)

  When making a multiple graphic selection hold Ctrl

- **Cut the Fiducials**, Edit > Cut

  ![Cut Fiducials](image4)

  The components will not be removed until a destination is specified. This feature prevents accidental loss of data in the cut and paste buffer.

- **Select the Frame and Paste**, Edit > Paste
Regular Multiboard Definition

To define a regular Multiboard the following information is required:

- The ‘offset’, the distance between each board in X and Y
- The number of boards in X and Y
- The Board Dimensions should be accurately defined

If the Repeat is not known accurately it can be found during creation of the Multiboard.

To create a regular Multiboard:

- Select the Miniboard to be repeated
- Right click and select Array Clone from the context menu

The X and Y offset are pre set to the dimensions of the board or miniboard

- Enter the number of boards to be created in X and Y
- If the precise offsets are known they should be entered in X and Y
- Click Preview to see the result

- Click OK to accept the settings
To graphically edit the X and Y offset;

- Select all the boards or miniboads
- Select the Move Tool 🔄 from the Toolbar
- Click on the central marker 🔄 to switch to rotate mode
- Click on the central marker 🌐 to switch to Multiboard mode

The Multiboard edit marker 🌐 is shown and handles are added at the top and right of the selection.

- Drag the right handle until the X offset is correct
- Drag the top handle until the Y offset is correct
- When satisfied with the values deactivate the Move Tool
Irregular Multiboard Definition

Irregular Multiboards are created by the cloning and graphical manipulation of Miniboards.

Before defining an irregular Multiboard check;

- The Miniboard size (and optionally the shape) are correctly defined

To define the shape of a Miniboard the Polygon must be edited.

To create an irregular Multiboard;

- Select the Miniboard to be repeated

- Right click and choose Clone (or press Ctrl + D)

- Select the Move Tool from the Toolbar and move the cloned board into position
• Rotate the cloned board if necessary by clicking the central marker to switch to rotate mode.

The rotate tool works in steps of 15°, if free rotation is required hold Shift when using the tool.

• Repeat until all Miniboards are defined.

If the Step and Repeat values are known, the position of each Miniboard can be edited in the Property Editor.

The Miniboard number can also be defined in the Property Editor, this number will be used when presenting defect data to the repair operator and by Yield Advisor™.
Multiboard Editing

To support editing of Multiboards without the need for recreation of the Miniboards in the case of a change the Content Manager is provided.

When activated the Content Manager will track all changes made to a single Miniboard and when de-activated (or when the edited Miniboard changes) will apply all the changes to all other Miniboards.

To edit using the Content Manager,

- Select a component in the Miniboard you wish to edit
- Switch on the Content Manager in the button bar
  - The icon changes to indicate the tool is active, and components will not be drawn for the inactive Miniboards.
- Carry out any editing that is needed
  - The icon changes to indicate that the other Miniboards will be updated when finished
- When complete click the Content Manager

Multiboard Windowize

Once a Multiboard is defined it must be Windowized.

- Select Tools > Windowize > Windowize.
  - The Inspection Recipe will be Windowized in the most efficient way possible, regardless of Miniboard or Board boundaries.
Block Skip

When testing Multiboards it can be necessary to abort testing of a particular miniboard within the Multiboard.

This is achieved by adding a Block Skip mark to the recipe, when such a test fails the testing of the parent (miniboard, board or frame) is aborted.

To add a Block Skip mark to a recipe;

- Select the appropriate Frame, Board or Miniboard in the table editor or graphically.
- Right click, and in the context menu select Insert > Component
- A component with an UNDEFINED Inspection Type is added.
- Move and resize the component as necessary
- In the Property Editor right click the Inspections tab, and select Change Inspection Type > Tool

  Setting a Block Skip is also possible with inspection type Macro

- In the Inspections tab of the Property Editor turn off the Location inspection

- In the Inspectors tab of the Property Editor double click on the already added Inspector and change to macro.1

- In the Inspectors tab of the Property Editor double click on the already present Inspector and change to macro.1
• Open the inspector by clicking on \( \Rightarrow \) and change the Defect to Presence

![Property Editor: Component (untitled), type TOOL](image)

<table>
<thead>
<tr>
<th>Tool</th>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Inspector</td>
<td>macro.1</td>
<td>Macro Tool Inspector</td>
</tr>
<tr>
<td>Config</td>
<td>Open Config Dialog</td>
<td>Opens the configuration dialog</td>
</tr>
<tr>
<td>Defect</td>
<td>Location</td>
<td>The defect generated if test fails</td>
</tr>
<tr>
<td></td>
<td>Location</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Presence</td>
<td></td>
</tr>
</tbody>
</table>

• Configure the Test for the Block Skip by clicking on Open Config Dialog, see Macro Inspector for more details

• In the Component tab of the Property Editor turn on the Stop on Failure feature

![Property Editor: Component [SKIP], type TOOL](image)

The component can also be named in this tab. It is also recommended to add the component to the Package Library

• Windowize the recipe, using Tools > Windowize > Windowize

![Image](image)

If you used the Content Manager turn it off before Windowize

When this component fails, testing of the containing Miniboard, Board or Frame will be aborted.

Components with Inspection Type FIDUCIAL or HEIGHT_SYNC automatically behave as Block Skip. If these components fail the testing of the parent is aborted.
Barcode Scanning

Overview

Barcode Scanning in the Symbion is achieved either with a traditional external scanner connected to the system or optionally by reading the barcode during the inspection cycle.

Barcode reading during the inspection cycle requires a license and dongle be installed on the system.

The software Barcode reading is capable of reading the following types;

- Code 39, 128
- UPC-A, E
- EAN-8, 13
- Interleaved 2 of 5
- BC-412
- Codabar
- 2D Data Matrix
Recipe Setup

Regardless of the method used to read the Barcode (Hardware or Software) the Inspection Recipe must contain at least one Barcode marker. This marker is used to identify how the barcode can be used:

- As read
- To be added to children (for example Miniboards)

The marker must be added to the Frame.

To add the Barcode:

- Select the Frame in the Recipe Tree Editor.
  
  ![Image](image)

  In the Recipe Editor switch between Table and Tree view modes by clicking on.

- Right click, and in the context menu select Insert > Barcode

- In the Property Editor choose the Autoincrement method.
Barcode Component Setup

When using software barcode reading a component must be added to the recipe for each barcode to be read.

To setup the Barcode Component;

- Select the appropriate Frame, Board or Miniboard in the table editor or graphically.
  
  When setting a Block Skip on a Miniboard or Board use the Content Manager to ensure the work is duplicated on the other Miniboards or Boards, see Multiboard Editing for more details

- Right click, and in the context menu select Insert > Component

A component with an UNDEFINED Inspection Type is added.

- Move and resize the component as necessary

- In the Property Editor right click the Inspections tab, and select Change Inspection Type > Barcode

- In the Inspectors tab of the Property Editor check the already added Inspector and if necessary change to barcode.linear.instant.ff (1D codes) or barcode.matrix.instant.ff (2D Data Matrix)

  The component can also be named in this tab. It is also recommended to add the component to the Package Library

- When the component is tested the Barcode will be decoded.

- Windowize the recipe using Tools > Windowize > Windowize
Maintenance

Overview

The Maintenance Module is used to calibrate and verify the Symbion hardware, the following calibrations and checks are available:

- Verify the Camera Alignment
- Verify the Camera Brightness
- Verify the Flash Alignment
- Adjust the Flash levels
- Run the ‘Grid’ Calibration
- Run the ‘Adapter’ Calibration
- Run the Machine Capability Tests (MCT)

Each of these requires the use of a standard test card, which is included with every system.
Test Card

The Test Card CC0103 has the following;

- **Standard Grey Area**
  
  The grey area is used to verify and adjust the brightness of the cameras and flashes.

  The grey area is a standard with a verified density of 0.40 ± 0.05

  Test Cards are verified before release with a standard verified by a certified national laboratory, and the density of the grey area is recorded on the back of the card.

    ![It is recommended to have the grey area verified yearly by an accredited laboratory](image)

  Care must be taken when handling the Test Card that the grey area remains clean and unmarked.

    ![Always store the Test Card in the case provided](image)

- **Cross Target**

  The cross target is used during verification of the camera alignment and the grid calibration
Service / Maintenance

All necessary system checks and calibrations are carried out through the Service / Maintenance section of the Maintenance Module.

- In the Maintenance view click Service/Maintenance

The Service / Maintenance view is displayed, it has two main panels

- Periodic Maintenance

  Here the current status of all periodic checks and calibrations is displayed, those with red time stamps have expired.
  
  An expired check or calibration will display a warning on the system.
  The periods over which the checks expire are defined by Orbotech Customer Support.

- Service

  Most functions here are described in the Service Manual except the MCT
Load the Test Card

Before any check or calibration can be carried out the test card must be loaded.

If any check is started before the test card is loaded the system will start the procedure for loading the test card:

- Click [Playground] to open the playground

- Use the X and Y sliders to move the adapter such that the Test Card can be loaded into the adapter (by opening the front doors)

- Set X to minimum and Y to maximum to drive the adapter to the front right corner of the system

- Enter the test card width in the Board Size

  - For CC0103 the width is 178mm, for the older TC4797B the width is 220mm

- Load the Test Card into the Adapter by opening the front doors

  - Slide the Test Card all the way into the adapter, as far as the stoppers. The ‘Orbotech’ marking should by in the lower left corner.

- Close the front doors and power the system by pressing the Green button marked ‘I’ on the front panel.

- Close the Playground by clicking on [X]
• Click **Select Target** to open the Target Selection dialog

• From the Selected Calibration Board drop down select the type of Test Card to be used

  ![Image](image.png) Normally the CC0103 is used

• Click **Center Cross**

  The system tries to align the test card automatically, when successful a green check mark is displayed.

  If this fails use the Jog buttons until the cross is in the center of the view, and click on Center Cross again

![Diagram](diagram.png)

  The amount of movement caused by the Jog buttons, Up, Down, Left and Right can be adjusted with the Step slider

• Click **Exit**
Camera Alignment Check

The Camera Alignment check verifies the correct alignment of the four angled cameras with the top camera.

This check is automatic and uses the cross target on the test card.

• Click

When the check is completed the date is refreshed and colored for the result. A failing check will show a cross in the button.

If the check fails it may be necessary to re-align one or more cameras, refer to Service Manual

Brightness Adjustment Check

The Brightness Adjustment check verifies the correct brightness of the cameras, relative to the top camera.

This check is automatic and uses the grey target on the test card.

• Click

When the check is completed the date is refreshed and colored for the result. A failing check will show a cross in the button.

If the check fails it may be necessary to adjust one or more cameras, refer to Service Manual

Flash Alignment Check

The Flash Alignment check verifies the proper alignment of the flashes.

This check is automatic and uses the grey area on the test card.

• Click

• Click Yes to confirm warming up the flashes before the check

It is recommended always to warm up the flashes before any check, this process takes two and a half minutes.

When the check is completed the date is refreshed and colored for the result. A failing check will show a cross in the button.

If the check fails the system will initiate the Flash Level Adjustment, in case of further failure refer to Service Manual
Flash Level Adjustment

The Flash Level Adjustment checks the output of the flashes, and adjusts the outputs if necessary.

This check is automatic and uses the grey area on the test card.

- Click \(\checkmark\) Flash Level Adjustment
- Click Yes to confirm warming up the flashes before the check

It is recommended always to warm up the flashes before any check, this process takes two and a half minutes.

When the check is completed the date is refreshed and colored for the result. A failing check will show a cross in the button.

If the check fails it may be necessary to replace one or more flash tubes, refer to Service Manual

Grid Adjustment

The Grid Adjustment checks the motion of the machine with respect to the optical head, this creates a geometric correction.

This check is automatic and uses the cross on the test card.

- Click \(\checkmark\) Grid Adjustment

The Adjustment will take approximately 10 minutes; the system should be undisturbed in this time.

When the check is completed the date is refreshed and colored for the result. A failing check will show a cross in the button.

If the check fails it may be necessary to make a calibration of the optical head, refer to Service Manual